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Meanings of symbols used

The following table shows the symbols used in this manual, along with descriptions of what they mean.

CAUTION Indicates something that may cause injury or damage to the projector.
@ TIP Indicates information that is related to a topic or which may be useful to know.
- Indicates a page where a related topic or a more detailed explanation is provided. Click on the page

number to display that page.

[ (Name) | Indicates the name of a projector port or a computer menu or item name.
Example: [InputA] [Start]
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Tasks that can be done using EMP Monitor

EMP Monitor lets you carry out operations such as checking the statuses of
multiple EPSON projectors that are connected to a network at a computer
monitor, and controlling the projectors from the computer.

Following are brief descriptions of the monitoring and control functions that
can be carried out using EMP Monitor.

« Registering projectors for monitoring and control

- Projectors on the network can be searched for automatically, and you can

then select projectors to be registered from the projectors that are detected.

- You can enter the IP addresses for target projectors to register them.
 Registered projectors can also be assigned to groups so that they
can be monitored and controlled in groups
» Monitoring the statuses of registered projectors

- The power status (ON/OFF) for projectors and problem and warning
statuses can be checked visually by means of icons.

- You can select groups of projectors or a single projector that you are
interested in, and then check the cumulative lamp operating time or check
the details of information on input sources, problems and warnings for
these projectors.

« Controlling registered projectors

- Projectors can be selected in groups or as single projectors, and you can
then carry out operations for the selected projectors such as turning the
power on and off and switching their input sources.

- Web control functions can be used to change the settings in the projector's
configuration menu.

- If there are certain control actions which are carried out regularly at
particular times or on particular days, you can use "Timer Settings" to
register timer settings.

« E-mail notification function settings

You can set e-mail addresses for problem notifications to be sent to if a

problem occurs with a projector that has been registered.

| wantto turn on the
power for Group A
projectors.

o

Projector A

-

Projector B

EMP Monitor

System configuration example

@ TIP

To enable projectors to be monitored and controlled even when they
are in standby mode*, make the following settings at the projectors.
The settings that need to be made will vary depending on the projector
you are using.

@ ""Configuration menus'' in the projector's User's Guide.

o Set ""Network Monitoring'' to "ON"'.

e Set '"Standby Mode'' to '""Network ON'"'.

* When the projector's () (Power) indicator is lit orange



Operating environment )

Compatible computers 2 ) Place the "EPSON Projector Software for Monitoring"
CD-ROM in the computer's CD-ROM drive.

The installer automatically starts up.

Macintosh computers cannot be used.

oS 98SE/Me/NT4.0/2000 Professional/XP Home Edition/XP
Professional From here, continue with the installation by followin
e Internet Explorer Ver. 5.0 or later must be installed. 3 the on-scr:aen messages. v 9

CPU Pentium MMX 166 MHz or higher (Pentium II 233 MHz
or higher recommended)

Memory 64 MB or more (128 MB or more recommended)

capacity . .

Free hard disk | 50 MB or more Before starting operations

Space

DP | SVGA (800<600) or hieh Tution. 32 bit or hieh Check the following points before starting up EMP Monitor.

Ispiay display (coloir ) or higher resolution, itor higher * EMP Monitor must be installed on the computer to be used for

monitoring and control.

* Operations carried out at the computer may become slow depending on the * The computer and the projectors must be connected to the network.
number of projectors being managed. If this happens, use a computer with * If using Windows 2000, NT4.0 or XP, the computer must be started up in
higher specifications. Administrator mode.

* EMP Monitor cannot be used in environments which do not allow pings to
be transmitted. When using EMP-6000/821/81/61

* A commercially-available serial < TCP/IP conversion adapter and a
. . connection cable are required in order to use EMP Monitor.
InSta"mg EMP Monitor @ "Standby mode" in the projector's User's Guide
* Make the settings for the serial < TCP/IP conversion adapter before
connecting to the projector.

If using Windows 2000, NT4.0 or XP, the computer must be started up in
Administrator mode.

PROCEDURE

1 ) Turn the computer on, and quit all running
applications.



Registering and deleting projectors for monitoring

This operation is carried out when starting EMP Monitor for the first time after
it has been installed and when you would like to add projectors. Once a
projector has been registered, the status for the projector will be displayed
automatically each time EMP Monitor is started from that point onwards.

Starting EMP Monitor

| PROCEDURE

Click [Start] - [Programs] (or [All Programs]) - [EPSON
Projector] - [EMP Monitor V4.10] in that order to start
EMP Monitor.

@ The main window will be displayed.
"Grouping view"

Fle Edt View Tool Help
Refresh Select al b (D EE EE ooo @ [==]

The operations to register projectors using the automatic search will
vary depending on where the projectors are connected to in the
network.

*When registering a projector that is located in the same segment
that the computer the EMP Monitor is installed in is associated
with. @ "Registering projectors using automatic search (Searching
for and registering projectors that are located in the same segment)"
p.7

*When registering projectors that are in multiple segments of the
network @™ "Setting the range of addresses to do an automatic
search and registration" p.9



Registering and deleting projectors for monitoring

Registering projectors using automatic search 2 Click [Search].
(SearChl_ng for and registering projectors that are Automatic search will be carried out, and the names of the
located in the same segment) projectors that have been detected will be displayed.

* If a projector does not appear in the list, use "Registration by
specifying an IP address (Manual registration)". @ p.11

P ROC E D U R E Create new projeckor (aukomatic registration)

Projector name IP address
. Projector10 192168040
M Procedures for automatic search Projectar 192168041
Projector12 192168.042
1 ) Right-click in "Grouping view" and select "New" - e It
"PrOieCtor (automatic search)". Projector1B 192168045
Projector1f 192168046

The "Create new projector (automatic registration)" window
will be displayed.

o If "Detail list view" is displayed, select "New" - "Projector
(automatic search)" from the "Edit" menu.

[ Specify an address range and search,
Start address End address

Search Edit Cancel

Create new projectar {automatic registration)

@ TIP

® You can also carry out this operation by selecting ''Projector
(automatic search)' from '"New'' in the ""Edit" menu.

e Projectors that are using a serial < TCP/IP conversion adapter
cannot be detected.

[ Specify an address range and search.

Start address End address

Search Edit Cancel




Registering and deleting projectors for monitoring

I Procedures for registration

3 ) Select the projector(s) to be registered, and then click

[Edit].

The following window will be displayed.
Make the necessary settings while referring to the following

table.

Create new projector {automatic search)

Dizplay name

Dizplay icon

Parent group
Projector name

IP address

-
Part Mumber
fonitor Password

Description

Iv Monitar

< [ ﬂ
| [(Mane] ﬂ
| Projectari
| 160 . o84 . 183 . 1D Search
—

Register Cancel

Display name

Enter the name of the projector(s) to be displayed in
"Grouping view" or "Detail list view".

Up to a maximum of 32 bytes can be entered.

A space cannot be used as the first character.

Display icon

Select the icon(s) to be displayed in "Grouping view"
or "Detail list view".

Parent group

Select when registering a projector in a group.
If no groups have been created, this cannot be
selected. @™ "Registering several projectors to a
monitoring group all at once" p.12

Projector This shows the name that has been registered on the
name projector.

IP address This shows the IP address for the registered projector.
Use Serial & | This cannot be selected when registering projectors
TCP/IP using automatic search.

conversion

adaptor.

Port Number

This cannot be selected when registering projectors
using automatic search.

Monitor
Password

If a Monitor Password has been set for the projector,
be sure to enter the Monitor Password that has been
set. If the correct password is not entered at this time,
it will not be possible to monitor and control the
projector even though it is registered.

Description

You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor

Select this when you want monitoring to start.

4 ) After entering the details, click [Register] to start the
registration. When the message is displayed, click

[OK].

To continue registering other projector(s), repeat Steps 3 and 4.

@ TIP

Projectors that have been registered using automatic search are
searched for again by projector name each time EMP Monitor is
started.



Registering and deleting projectors for monitoring

5 ) To end the registration operation, click the [X] in the 2 ) Select the "Specify an address range and search"
top-right corner of the window or click [Cancel]. check box and then enter the starting address and

The icon(s) of the projector(s) you registered will be displayed ending address in the range.

in "Grouping view" or "Detail list view".
Refer to "Monitoring window layout" for details on using the
"Grouping view" and "Detail list view". @ p.16

Setting the range of addresses to do an automatic
search and registration

v

=L L= Edit ancel

I Iv S’EEIFV an address 1 :
@ TIP Start address 192 . 168 . 0 . 00 nd address 192 . 168 . 0 . 50

Projectors that are using a serial < TCP/IP conversion adapter

nnot tected. c
cannpgleleeected 3 ) Click [Search].
Automatic searching will be carried out, and the names of the
PROCEDURE projectors that have been detected will be displayed.
M Procedures for automatic search e e
. . . n 0 Frojector1l 192.168.0.41
1 ) Right-click in "Grouping view" and select "New" - Foketa2 2168042
"Projector (automatic search)". " oo
The "Create new projector (automatic registration)" window i e

will be displayed.

o If "Detail list view" is displayed, select "New" - "Projector
(automatic search)" from the "Edit" menu.

[V Specify an address range and search.
Start address 192 . 168 . 0 . 00 End address 192 . 168 . 0 . 50

Edit Cancel




Registering and deleting projectors for monitoring

I Procedures for registration

4 ) Select the projector(s) to be registered, and then click

[Edit].

The following window will be displayed.
Make the necessary settings while referring to the following

table.

Create new projectar {automatic search)

Display name

Display icon

Parent group

Projector name

IP address

-

Part Murnber

Monitor Pazsword

Drezcription

v Monitar

¢

4

| [Mone] j

| Projector10

| 188 . 254 . 183 . 181 Search

—
|

Begister Cancel

Projector This shows the name that has been registered on the
name projector.

IP address This shows the IP address for the registered projector.
Use Serial< | This cannot be selected when registering projectors
TCP/IP using automatic search.

conversion

adaptor.

Port Number

This cannot be selected when registering projectors
using automatic search.

Monitor
Password

If a Monitor Password has been set for the projector,
be sure to enter the Monitor Password that has been
set. If the correct password is not entered at this time,
it will not be possible to monitor and control the
projector even though it is registered.

Description

You can enter some kind of memo about the projector.
The details you enter here will be displayed at the
projector properties.

Up to a maximum of 60 bytes can be entered.

Monitor

Select this when you want monitoring to start.

Display name

Enter the name of the projector(s) to be displayed in
"Grouping view" or "Detail list view".

Up to a maximum of 32 bytes can be entered.

A space cannot be used as the first character.

Display icon

Select the icon(s) to be displayed in "Grouping view"
or "Detail list view".

Parent group

Select when registering a projector in a group.
If no groups have been created, this cannot be
selected. @™ "Registering several projectors to a
monitoring group all at once" p.12

After entering the details, click [Register] to start the
registration. When the message is displayed, click

[OK].

To continue registering other projector(s), repeat Steps 4 and 5.

To end the registration operation, click [X]| in the top-
right corner of the window or click [Cancel].

The icon(s) of the projector(s) you registered will be displayed
in "Grouping view" or "Detail list view".

Refer to "Moitoring window layout" for details on using the
"Grouping view" and "Detail list view". @ p.16
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Registration by specifying an IP address (Manual 2\ Enter the IP address of the projector to be registered
registration) in the "IP address" box and then click [Search]. When
the message is displayed, click [OK].

* If using a serial < TCP/IP conversion adapter and cable to connect

PROCEDURE the projector, select "Use Serial < TCP/IP conversion adaptor".
Enter the port number in "Port Number" and then click [Search].

1 ) Right-click in "Grouping view" and select "New" -

"Projector (manual registration)". 3 ) After searching is complete, enter the information for
the projector to be registered while referring to the
table below.

The following window will be displayed.
o If "Detail list view" is displayed, select "New" - "Projector (manual

registration)" from the "Edit" menu.

Display name | Enter the name of the projector(s) to be displayed in

Create new projector {manual registration) "Grouplng Vlew" or "Detall llst ViGW".
Display name [ Up to a maximum of 32 bytes can be entered.
Displayfcon _ A space cannot be used as the first character.
e e Display icon | Select the icon(s) to be displayed in "Grouping view"
Jq | o or "Detail list view".
S s = Parent group | Select when registering a projector in a group.

If no groups have been created, this cannot be
selected. @™ "Registering several projectors to a

Projector name ‘

[Raiics I Search monitoring group all at once" p.12
| e Setdl < TERAP converson adaptor Projector This shows the name that has been registered on the
Poit Number [ name projector.
Monitor Passward | IP address This shows the IP address that you entered in step 2.
B Use Serial & | Select this if using a serial < TCP/IP conversion
_ TCP/IP adapter to connect the projector.
|v Monitar COﬂVGFSIOn
Begister Cancel adapto r.
Port Number | If using a serial < TCP/IP conversion adapter to
@ connect the projector, enter the port number.
TIP

You can also carry out this operation by selecting ''Projector (manual
registration)'’ from ""New'' in the ""Edit'" menu.
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Monitor If a Monitor Password has been set for the projector, Registering several projectors to a monitoring group
Password be sure to enter the Monitor Password that has been all at once
set. If the correct password is not entered at this time,
it will not be possible to monitor and control the Projectors that have been registered can then be registered together into
projector even though it is registered. If using a serial different groups so that they can be monitored and controlled together.
& TCP/IP conversion adapter to connect the Furthermore, if you select one of the registered groups as the "Parent
projector, the Monitor Password security function group", monitoring and control operations can be carried out for all
cannot be used. projectors in that "Parent group".
Description You can enter some kind of memo about the projector. A "Parent group" can be set for other parent groups, so that a hierarchical
The details you enter here will be displayed at the group arrangement such as the following can be created.
projector properties.
Up to a maximum of 60 bytes can be entered. Branch A —— Showroom Showroom A No1
Monitor Select this when you want monitoring to start. ‘ No2
No3
Showroom B No4
4 )\ After entering the details, click [Register] to start the _ Lobby No5
r(e)glg(lstratlon. When the message is displayed, click | Convention hall Projector01
[ 1 [ Projector02
The icon(s) of the projector(s) you registered will be displayed
in "Grouping view" or "Detail list view". Branch B Conference room 18?
102
103
Reception room Room 1
L Room 3
Branch C Conference room 201
I— 202

First, create the registration groups, and then register projectors into the
groups that have been created.
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@ TIP

You can also carry out this operation by selecting '"Group'' from
""New'' in the "Edit' menu.

PROCEDURE

1 ) Right-click in "Grouping view" and select "New" -
“Group".

The following window will be displayed.
Make the necessary settings while referring to the table below.

o If "Detail list view" is displayed, select "New" - "Group" from the
"Edit" menu.

2 | After entering the details, click [Register] to start the
registration. When the message is displayed, click
[OK].

The icon(s) of the projector(s) you registered will be displayed
in "Grouping view" or "Detail list view".

Group name | |

Dizplay jcon

Right-click the projector icon(s) to register to the
group you have created in "Grouping view" or "Detail
list view", and select "Edit".

@ TIP

You can also carry out this operation by selecting "'Edit'' from the

] | 3

Parent group |[N ane) j

-

FReaister Cancel

Group name | Enter the name of the group(s) to be displayed in "Edit" menu.

"Grouping view" or "Detail list view".

Up to a maximum of 32 bytes can be entered.

A space cannot be used as the first character. 4 ) Inthe "Edit projector" window, select the group name
Display icon | Select the icon(s) to be displayed in "Grouping view" to use for registering in "Parent group" and then click

or "Detail list view".

Parent group

This selects the parent group. If no groups have been
created, this cannot be selected.

Monitor

Select this to monitor all projectors that have been
registered in the group. If this is not selected, the
settings made when the individual projectors were
registered will be used.

It cannot be set when creating a new group.

[Change].

The status of the group registration will be displayed as an icon
in "Grouping view" or "Detail list view".

@ TIP

The registration details can also be checked using ''Projector list' in
the ""View' menu.
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If the projector name or IP address changes after M For projectors that have been registered using automatic
registration search
PROCEDURE

I For projectors that have been registered manually

1 ) Delete the projector(s) whose name or IP address has
PROCEDURE been changed in "Grouping view" or "Detail list
: : : S Lo view". @ p.15
1 ) Right-click on a projector icon in "Grouping view" or
"Detail list view" and select "Monitoring disabled".

Then right-click the projector icon again and select 2 ) Carry out automatic search to re-register the
"Edit". projector(s). @ p.7

@ TIP

You can also carry out these operations by using the ""Edit'' menu.

2 ) If only the projector name has been changed, click
[Search] in the "Edit projector" window that is
displayed.

If the IP address has been changed, enter the new IP
address in the "IP address" box and then click
[Search]. When the message is displayed, click [OK].

3 ) When the display returns to the "Edit projector"
window, click [Change].



Registering and deleting projectors for monitoring

Cancelling (deleting) projector registrations

The registrations for projectors can be deleted if they are no longer
required for monitoring or control using EMP Monitor.

| PROCEDURE

Right-click the icon for the projector or group that is to be

deleted in "Grouping view" or "Detail list view" and select

“Delete".

When the message is displayed, click [OK].

More than one projector can be selected for deleting by selecting in

"Grouping view" or "Detail list view".

The methods of selecting more than one projector at the same time are as

follow.

* If you select a group icon in "Grouping view", all projectors that have
been registered in that group will be deleted at the same time.

* Hold down the [Ctrl] key on the keyboard while clicking on the desired
icons.

 Use drag and drop to select a range of desired icons.

TIP

You can also carry out this operation by selecting ""Delete" from the
"Edit'" menu.




Monitoring window layout

You can monitor using either of the window layouts below.

« "Grouping view"
This view lets you check the status of group registrations in a hierarchical
diagram.

« "Detail list view"
This view lets you display the status of each projector as a list so that the
projectors can be checked in detail. You can also display specific items as a
list, and sort display items using a specific row as a sort key.

EX
Tool  Help e
VO BB -HmE =@

Edt  yiew Jool Hep

seaa |

ST . e
m— e

Reteh e W

Branch A/Shawroam/Shonroom A Not

Branch B Branch O

PPEEPEREHERREBED
0000000000009 0

"Grouping view" "Detail list view"

¥ How to switch views

"Grouping view" and "Detail list view" are switched as follows.

PROCEDURE \

Click the "View" menu, and select "Grouping view" or
“Detail list view".

Monitoring using "Grouping view"

16

I Meanings of "Grouping view" icons

In "Grouping view", the patterns on the icons indicate the statuses of the

projectors.

a;! EMP Monitor V4,10

Refresh Select all

File  Edit ¥ew TIool Help

oo

E~-FuBe®

-—

A

Showroom A

we T

Mol N2

Showroom

Lobby

Conwention
Hall

Showroom B

Mo

Branch G

Branch B

—"Grouping view"

\If the group

icons are round
in shape, it
indicates that
there is another
level below
them. @ p.17




Monitoring window layout

The icon patterns and their meanings are explained below.

No warnings or problems
All projectors in the group are normal.

A Warning or problem
A projector in the group has a warning or problem
status.

. Monitoring disabled

The projector is not being monitored. If you right-
click the icon and select "Monitoring enabled", the
projector will be added to the projectors that are
being monitored.

Data being updated

Projector

*1

£

No warnings or problems

Warning or problem

. Monitoring disabled

e Data being updated

e Network error (Monitor Password error)

S No Monitor Password was entered when the projector
was registered, or an incorrect Monitor Password was
entered. @ p.8, 10, 12

b Network error (TCP connection error) 2

A Network error (ESC/VP.net communication

?

error) °

f

*1 When "Temperature level display group view" is set to "On" at
"Environment setup"” in the "Tool" menu, an icon indicating the internal
temperature of the projector will be displayed on top of the projector
icon. The default setting is "Off". As you can get an idea of how the
temperature inside the projector is increasing when the internal
temperature level is displayed, you can make improvements to the
projector's operating environment before a high internal temperature
alarm occurs or the temperature becomes abnormally hot. @ p.22

*2 Check the following items.

* Check that the projector's power is turned on.

* Check that the LAN cable is connected.

* Check that "Network Monitoring" is set to "ON" or "Standby Mode"
is set to "Network ON" in the projector's configuration menu.

*3 Check that the projector has been correctly connected to the network.

@ TIP

The projector information that is generated when a problem is
detected is stored until EMP Monitor is closed. The EMP Monitor
displays will not be updated automatically even if the projector status
returns to normal. Click [Refresh] in the main window to update the
status.

M Using the icons in "Grouping view"

The following icon operations can be carried out in "Grouping view".

» Expanding and collapsing icons
Each time you double-click a group icon, the icons for the projector that
have been registered in that group are displayed or hidden.

» Moving icons
To change the position of an icon within "Grouping view", simply drag
and drop the icon to be moved.
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Monitoring using "Detail list view" Monitoring disabled
The projector is not being monitored. If you right-click
. . . s the icon and select "Monitoring enabled", the projector
" Meanings of "Detail list view" icons will be added to the projectors that are being monitored.
The status of registered projectors is displayed as a list in "Detail list view" e Data being updated
regardless of which groups the projectors belong to. .
7 e Network error (Monitor Password error)
————— =¥ | No Monitor Password was entered when the projector
Refesh Sekctal B ) =] e g = was registered, or an incorrect Monitor Password was
Type | Group name [ Display name_~ Fower [ Lamp Hous [ Temperature lvel entered. @ p8, 1(), 12
(@)  Erancha Labky @ 33H I I
@ Braneh /Showrosm/Shonreom A Mot @ 1204 | %-(’HJ Network error (TCP connection error) 2
@ Branch A/Showraom/Shawraom & Mo2 @ 60H [ b
L i B i o o — &8 | Network error (ESC/VP.net communication error) ©
@)  Branch A/Shomroom/Showroom B Nod @ OH | =
@@ Bronch AfSrowoomShowrosm B oS ) oM O Group name: When projectors are registered to a group, the name of
B | ol Proketord! L o — the group that the projector belongs to is displayed.
8] Branch AfConvention Hall Projector(2 @ BaH | —— - =
P — " o . S Display name: Shows the display name.
68  Drench B/Confence Room 0 @ 100+ —— Power: Shows the power on status for the projector.
B Branch BConference Reom 102 Q@ 35H —— Power on and normal Power on and
£  Branch B/Conterence Room 103 @ 78H -
= : status abnormal status
g Branch B/Reception Room Raom 1 Q@ 7aH I E—
@& Bronch B/Aeosption Foom oz 3 @ #0k [ — Power off and normal Power off and
| 2l

status abnormal status

Temperature level: The following five icons display the differing
internal temperature status of the projector.

The icon patterns and their meanings are explained below.

Type: Displays the projector status.

Internal temperature High-temperature
@2 | No warnings or problems* normal warning
Warni bl Internal temperature Internal temperature
e arning or problem ] error

An error has occurred on the projector. ]
High-temperature

warning
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Error information: Shows the warning or problem status using the W Selecting display items

following icons.

You can select only the required items to be displayed in "Detail list view".

g Lamp life warning™* 7] Lamp out
High-temperature = Lamp failure at PROCEDURE
@ warning | 2 power on
. . n H n n H n
@ Replace Air Filter [@] tngh mtternal 1 ) Select thloh from.the Ylew menu.
: empetature error The "Option" window will be displayed.
- Internal (system)
______ ' No Air Filter error
= . - _
. Low Air Flow :5‘3 Fan error S
— . I Type
[EZ | AirFlow Sensor Err. I Sensor error 2 o nee
) Open lamp cover [ Projector name
I door error (lamp Other error W Display name
error) T [ IP address
*1 When "Temperature level display group view" is set to "On" at v Bower
"Environment setup" in the "Tool" menu, an icon indicating the internal W Lamp Hours
temperature of the projector will be displayed on top of the projector | Saures
icon. The default setting is "Off". ¥ Temperatus evel
*2 Check the following items. B 2
* Check that the projector's power is turned on. LAl e
* Check that the LAN cable is connected. 0K —

* Check that "Network Monitoring" is set to "ON" or "Standby Mode"
is set to "Network ON" in the projector's configuration menu.
*3 Check that the projector has been correctly connected to the network. 2\ Select the check box of the item you want to display.
*4 You can display the lamp life warning at any time preset at
"Environment setup" in the "Tool" menu.

@ TIP 3 Click [OK].

The projector information that is generated when a problem is
detected is stored until EMP Monitor is closed. The EMP Monitor
displays will not be updated automatically even if the projector status
returns to normal. Click [Refresh] in the main window to update the
status.
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When all of the details of the item cannot be displayed = Searching for desired icons (Projector list)

in "Detail list view", drag the boundary line on the
right of the item name so that the view is extended to The "Projector list" feature is useful for searching in lists when many

the desired width. groups and projectors are registered and the icon you are looking for is not
displayed on screen.

| PROCEDURE

I Sorting lists

Select "Projector list" from the "View" menu.
You can sort detailed lists by using a specific row as a sort key, such as

projector name order or IP address order.

Caotrvention Hall

" PROCEDURE \ &) shonoar
= Showroom £

n a M Mol
Click the item name of the row you want to use as the sort key. @Ei With "Projector list", temperature
5 (5) Shownaom B level icons are not displayed

< (&3 Branch B regardless of the setting of
+ (&3 Branch C “Temperature level display group
view" at "Environment setup".

The "Projector list" lets you check the registration details for groups in a
hierarchical diagram. When you click on an icon, "Grouping view" and

"Detail list view" are scrolled so that the selected icon is displayed in the
window.



Monitoring window layout

Monitoring using the system tray PROCEDURE

Uiz rojector statuses are a,l,way,,s Ve leons in (D EPRITIN (EeyE 1 ) Select "Environment setup" from the "Tool" menu.
even when "Grouping view" or "Detail list view" is not always displayed,

and the statuses can be checked by the icon patterns. The "Environment setup” window will be displayed.
When the configuration menus are set using the following operations, an
icon appears in the system tray and the status can be monitored by means
of the icon's pattern.

2 ) Select "Resident in the task tray".

Enviranment setup

Update interval 5 5 minutes

Temperature level display group view = Off " On

Lamp schedule naotifization = 0 " On ,ﬂ Time
Log output = 0ff (" On

[ Register at startup

;1'.3‘;‘;{ in the task fray

[ Change the application lock password

LOld password |

Mew pazsword |

@ . NO problem Mew password [confirm) |
/% : Problem oK Carcel

3 Click [OK]I.

@ TIP

® Right-click the icon in the system tray to open a pop-up menu to
select the ""Open the main screen'' or "Exit"'.

o If ""Register at start up'' in the ""Environment set up'' is selected,
EMP Monitor starts automatically when the computer's power is
turned on.
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The icon patterns and their meanings are explained below.

Displaying projectors with problem or warning
statuses in a list

You can display a list of only the projectors which have a problem or
warning status.

| PROCEDURE

Select "Warning and Error Projector list" from the "View"
menu.

The following "Warning and Error Projector list" window will be
displayed.

Type: Shows the group or projector status. @ p.16

Display name: Shows the display name.

Power: Shows the power on status for the projector.

Power on and normal

status

Power off and normal

status

normal

Internal temperature
normal

High-temperature
warning

Power on and
abnormal status

Power off and
abnormal status

A Computer or .
If you move the ) T Video
mouse pointer over QOL=1 | Computerl
‘Warning and Error Projector list A A
° - the icon, details of E ) DVI or HDMI
1 | sekotal B DR RE the error and the QoL =2 Computer2 (Digital)
Type | Display name | Power | Lamp Hours | Source Temperature \eve@nformation remedy W|” be
Mo @R =GR = displayed. '
—— — 1000¢ | BNC =) | D-Video
O R O e —— I S-Vid Easy MP
— If you double-click in {1 | >-Vvideo @z*g—yﬂ:i sy
a line, the properties . . . o e
for that proF} ec?or will Temperature level: The following five icons display the differing
be displayed. internal temperature status of the projector.
« 2| @ p24 Internal temperature High-temperature

warning

Internal temperature
error
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Error information: Shows the warning or problem status using the Checking properties in detail

following icons.

You can check the properties of groups and projectors in detail.

E Lamp life warning* Lamp out
@ High-temperature =N Lamp failure at W Displaying group properties
i i) . . . .
warning ' poweron You can use either of the following methods to display the properties.
@ Replace Air Filter [@ High internal * Displaying the properties for all groups in "Grouping view"
! temperature error Right-click in "Grouping view" and then select "Property".
----- y No Air Filter Internal (system) * Displaying properties for specified groups
----- 2| — error Right-click an icon in "Grouping view" and then select "Property".
'1 Low Air Flow ffﬂ Fan error
= ) B SS~"=
:':_.': Air Flow Sensor Err. l%‘ Sensor error Type | Display name | Power | Lamp Hours | Source Temperature level | Ermor information .
= B showoom If you double-click
_ Open lamp cover © srowcom® e in a line, the
P door error (lamp T Other error @ @ w R = g:gggrgf: :tg’j:atc:r:itr
error
) will be displayed.

*You can display the lamp life warning at any time preset at "Environment
setup" in the "Tool" menu.
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M Displaying projector properties Displaying and deleting logs

Right-click on a projector icon in "Grouping view" or "Detail list view"
and select "Property".

In your web browser, you can check a transmission log of content such as
what has been controlled by the EMP Monitor, projector errors. You can
PROJGCIor properues (ot delete logs once you have checked them.

Einfnrmatiun‘f Timer
Group name Showraom &

Fiojector name EmMP248214 . . .
' When ""Log output'' is set to "'On'' at ""Environment setup'' in the

Display name Mol

P AR ""Tool'" menu, transmission logs are stored. The default setting is
Lamp Hours 38H v 'Off' "
Temperature level T
Drezcription
[Verslon information E ﬁgg;mhﬂ? } DlSpIayS the - Dlsplayl ng IOgS
projector firmware
Everinfemalion version. PROCEDURE

Select "Log" - "show" from the "View" menu.

The web browser will open and the communication logs up until that
time will be displayed.

i Deleting logs
PROCEDURE

Select "Log" - "Delete" from the "View" menu.
When the confirmation message is displayed, click [OK].

All logs will be deleted and details of EMP Monitor control
operations and details of projector errors from that point onward will
be recorded in a new log.
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Carrying out control using control buttons

Click the icon of a projector to be controlled in "Grouping view" or "Detail
list view", and click a control button to enable control of only that selected
projector.

You can also enable control of all selected projectors by selecting more
than one projector in "Grouping view" or "Detail list view" and clicking a
control button. The methods of selecting more than one projector at the
same time are as follow.

* If you select a group icon in "Grouping view", all projectors that have
been registered in that group and that are set to be monitored can be
controlled at the same time.

* Hold down the [Ctrl] key on the keyboard while clicking on the desired
icons.

» Use drag and drop to select a range of desired icons.

Tool el

Selsct sl

(0 ® =& == == m—Control buttons

Branch B Branch G

= SWitch source
*® Computer 1

Switches the input source to the [Computer]] port
or [Computer] port.

e Switch source
*% Computer 2

Switches the input source to the [Computer2] port.

— Switch source
BNC

Switches the input source to the [BNC] port.

o Switch source
S-Video

Switches the input source to the [S-Video] port.

= Switch source
Video

Switches the input source to the [Video] port.

Switch source
= DVI, HDMI

Switches the input source to the [DVI] port or
[HDMI] port.

Switch source
" D-Video

Switches the input source to the [D4] port.

Switch source
EasyMP

Switches to EasyMP or EasyMP.net.

@ TIP

® Some connected projectors may not be equipped with all of the
above ports or functions. If you click a button for a port or function
that is not available, nothing will happen.

® You can select objects to be controlled and use the control buttons to
carry out control operations even when the following are being

displayed. @& For details on each display p.22, 23
- Group properties

- Projector properties

The following table shows the meanings of the control buttons. - Warning and Error Projector list (Control operations can only be

carried out for projectors with a warning status.)

& Power On Turns the projector power on.

& Power Off Turns the projector power off.
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Carrying out control using a web browser (Web
control)

You can use the computer's web browser to change the configuration menu
settings for projectors.

PROCEDURE

1 ) Right-click on the icon of a projector to be controlled
in "Grouping view" or "Detail list view" and select
"Web control".

2 ) The web browser will open and the Web control
window will be displayed.

Web control lets you set the same details as the configuration menu for the
projector. Refer to the Projector's User's Guide for details on the
configuration menu.

@ TIP

You can select projectors and right-click on them to select '"Web

control'' even when the following are being displayed.

® Group properties @& p.23

e Warning and Error Projector list (Control operations can only be
carried out for projectors with a warning status.) @& p.22

26

Carrying out control using timer settings

This is useful for carrying out certain control operations such as turning a
projector's power on and off at specified times every day or every week.
Timer settings can be carried out either for a single projector only, or all at
once for all projectors in a group.

PROCEDURE

1

Select "Timer" - "Timer Settings" from the "Tool"
menu.

The following window will be displayed and you can then
check the timer setting status.

rojectors ate
= [E eranch & 4 (18/2005 4
o

e cenenton el SUN | WON | TUE | WED | THU | FRI | sAT
1 2 3 [ 5 3
3 0 | i1 iz | 13
B Mol 14 | 16 | & | 17 | 18 19 & a0
BT ho2 21 2z ] 24 ERENE
3 Ho3 ElEREREE

Display name Dake Time. Operation
@ Lobby 2005/08]18 19:03  PCZorInput B
8¢ Showroom A 2005/05/15 19:06  Power ON
By ShowroomB 2005/08/18 20:05  Power ON
3 o3 2005/08/18 20:07  Power ON

[z comentionHall l200siosii 2004 Poweroh

Enabled Disabled Add Edit Delete

Close

The colours in the lines of the list have the following meanings:

[ ]:Current day's timer setting

[ ]:When some of the projectors in the group have timer setting
enabled and others have it disabled for the current day's timer
setting

[ ]:When the current day's timer setting is a disabled setting

I : Timer setting for a day other than the current day



Using the control functions 27

The details that can be checked and operations that can be carried out at this I Procedures for new timer settings
time are given below.

2 ) When you click "Add", the following window is

_ Selects a group or projector to check the status of. displayed and the new timer settings are applied.
Projectors When a group is selected, the timer setting statuses for
all projectors in that group are displayed. Create New Timer
Shows the current day in a red box. Schedule mode —
Days for which timer settings have been made are shown
Date 1n bold. Date 20050504 -
Click _«| or | to switch to the calendar for the Time 19:29 |
previous or next month. Operation Poweron v
Timers Shows a list of the timer settings.
[Enabled] Switches the timer settings that have been selected from
[Disabled] the timer list between enabled and disabled.
[Add] Registers new timer settings.
0K Cancel
Lets you change the timer settings that have been

[Edit] selected from the timer list.
If a group has been selected for status checking, the
settings cannot be changed.

At "Operation", you can carry out the operations of turning the
power on and off and switching the input sources, similarly for
: : the control buttons on the main window. If you set the input
[Delete] Lets you delete timer settings that have been selected source switching, the projector's power will turn on at the timer
from the timer list. start time even if it is not on at the time. Because of this, it is not
necessary to make two separate timer settings for turning the
power on and switching the input source.

3 ) After completing the timer settings, click [OK].

The timer settings that have been made will be registered and
they can be checked in the displayed timer list.

& TIP

You can enable and disable all of the timer settings that have been
registered. Select ''"Timer'' - '"Enable'’ or ""Disable" from the ""Tool"
menu.



Setting the mail notification function k) e

The mail notification function can be used to send notification messages to 2 ) The "Set mail notification function" window will be
preset e-mail addresses when a problem or warning occurs with a projector displayed.
that is connected to the network. By using this function, the operator can be

: : : L , Set the following parameters.
notified of problems with projectors even when the operator is in a different

location from the projectors. et mai notfication Function
Mail natification function ~ On " 0OFF
@ TIP
¢ Up to three addressees (destinations) can be registered and SMTP server IP address Part Number E

messages can be sent to all of them at once.

e If a critical problem develops with a projector which causes it to
suddenly stop working, it may not be possible for the projector to
send a message notifying an operator of the problem.

Sender mail address

Motification ewvent

Fecipient mail address 1 | Motification vent
Fiecipient mail address 2 |

e If ""Standby Mode"' is set to ""Network ON"' or ""Network resREn nelastes s iR
Monitoring'' is set to ""ON'"' in the projector configuration menus, 0K Cancel
you can monitor the projector even when it is in standby mode
(when its power is turned off). @& Projector’s User's Guide Mail notification Set to "ON" to use the mail notification function.
® On some projectors, the mail notification function can be set in the function
configuration menu. When notification messages are set to be sent SMTP server Enter the IP address of the SMTP server.
in the projector’s configuration menu, both the settings in the IP address Up to a maximum of 255 bytes can be entered.
configuration menu and settings made on EMP Monitor are
Junctional. When you change a port number of the SMTP
server, specify this port number. The default value
is "25".
You can enter a valid number from 1 to 65535.
PROCEDURE Sender mail Enter the sender's e-mail address. Up to a
address maximum of 255 bytes can be entered.
1 ) Select "Mail notification function" from the "Tool" Recipient
ML mail address 1
Recipient Spe‘c.ify 'Fhe destil}ation addresses fqr thg
mail address 2 notification e—mgll. Up to three destinations can be
set. Up to a maximum of 255 bytes can be entered.
Recipient
mail address 3




Setting the mail notification function

3 ) Click [Notification event] and check the items for mail 5 ) When the setup is complete, click [OK].
notification in the window that appears.

Sek mail ne

Set notification event

<]

‘Lamp failure at power ar

<

Qpen lamp cover door eror [lamp errar]

<]

Lamp out

<]

Fan eror

<

Sensor error

High intgrnal termperature errar

<l

|nternal [zystem] emrar

<]

Other ermor

<]

Lamp life waming

Mo zignal

<l

Replace Air Filker
M Air Filker

< %

Loww Air Flow

<]

Air Flows Senzor En

<

High-temperature warning
Metwark erar [TCP connection error)

Metwark erar [ESCAP.net communication erraor]

B m

Metwork. enor [monitor paszword authentication emor)

QK Cancel

4 Click [OK].

When the "Set mail notification function" window appears
again, repeat Steps 3 and 4 to set the events to be notified.



If a problem notification e-mail message has been sent

If a problem occurs with a projector, an e-mail message containing the
following will be sent to all e-mail addresses that have been specified in
"Recipient mail address".

If there is more than one problem or warning, each message will appear on
separate lines.

Item Details shown

E-mail subject [Display name displayed in "Grouping view" or
"Detail list view"] Projector warning/error
notification

Body The following warning/error occurred on
<Display name displayed in "Grouping view"
or "Detail list view">.

<Warning/error message (Please see the table
below)>

Immediately check the projector.

The details contained in the e-mail message can consist of the following.

Message Remedy

Internal (system) error "Reading the indicators"
@ "Reading the Indicators" in the projector's
User's Guide

Fan error

Sensor error

Open lamp cover door
error (lamp error)

Lamp failure at power on

Lamp out

High internal
temperature error

High-temperature
warning

Message

Lamp life warning

Replace Air Filter

No Air Filter

Low Air Flow

Air Flow Sensor Err.

Remedy

"Reading the indicators"
@ "Reading the Indicators" in the projector's
User's Guide

No signal

No image signals are being received by the
projector. Check the connection status and
check that the power for the connected
equipment is turned on.

Other error

Stop using the projector, disconnect the
power cable from the electrical outlet, and
contact your local dealer or the nearest
address provided in the World-Wide Warranty
Terms supplied with the projector.

Network error (TCP
connection error)

Check that the projector's power is turned on
and the LAN cable is connected, and also
check that "Network Monitoring" is set to
"ON" and "Standby Mode" is set to "Network
ON".

Network error (ESC/
VP.net communication
error)

Check that the projector has been correctly
connected to the network.

Network error (monitor
password authentication
error)

Check the projector's Monitor Password.

Messages to inform that the projector has recovered from the error or

warning statuses are sent.



Application lock function

You can use the application lock to prevent third parties from operating the
projectors using EMP Monitor and from changing settings without authority.
Opening and closing EMP Monitor and status monitoring can still be carried
out even when the application lock is applied.

In addition, when a password has been set, the password must be entered in
order to cancel the application lock. This ensures that the application lock can
not be easily cancelled, and thus improves system security.

Switching application lock between enabled and
disabled

I Enabling the lock

PROCEDURE

Select "Application lock" from the "Tool" menu.
The application lock will be enabled and no operations will be

possible other than opening and closing EMP Monitor and disabling
the application lock.
I Disabling the lock
PROCEDURE

1 ) Select "Application unlock" from the "Tool" menu.

2 | The password entry window will be displayed, so
enter the set password and then click [OK].

If no password has been set (default setting), click [OK]
without entering a password. It is recommended that you enter a
password in order to strengthen security.

The application lock will be cancelled and operations can be
carried out as normal.

Setting a password for cancelling application lock

Carry out the following operations while application lock is cancelled.

PROCEDURE

1 ) Select "Environment setup"” from the "Tool" menu.
The "Environment setup" window will be displayed.

2 )| Select "Change the application lock password".

3 ) Enter the password in both the "New password" and
"New password (confirm)" boxes and then click [OK].

The password can be up to 16 bytes in length. Single-byte
alphanumeric characters can be used.



Troubleshooting i/l

Projectors cannot be monitored or controlled

Cause Remedy

An e-mail message is not sent when a problem
occurs with a projector

Is the projector connected to
the network correctly?

Connect the network cable correctly.
@ "Network Cable Connections" in the
projector's User's Guide

Has the projector been set
up correctly for connection
to the network?

Check the settings for the "Network"
configuration menu command.
@ Projector's User's Guide

Cause

Is the projector connected to
the network correctly?

Remedy

Connect the network cable correctly.
@ "Network Cable Connections" in the
projector's User's Guide

Has EMP Monitor been
installed on the computer
correctly?

Uninstall EMP Monitor and then re-install
it.

Has the projector been set
up correctly for connection
to the network?

Check the settings for the "Network"
configuration menu command.
@ Projector's User's Guide

Are all the projectors that
you want to control or
monitor registered?

Register the projectors. @ p.6

Have the SMTP server IP
address, port number and
recipient e-mail address all
been set correctly?

Check the setting details.

Is the projector's "Network
Monitoring" or "Standby
Mode" configuration menu
set to "ON" or "Network
ON"?

In order to use EMP Monitor to monitor
and control the projector when it is in
standby mode, the projector's "Network
Monitoring" or "Standby Mode"
configuration menu must be set to "ON" or
"Network ON".

@ Projector's User's Guide

Is the projector's "Network
Monitoring" or "Standby
Mode" configuration menu
set to "ON" or "Network
ON"?

To use the mail notification function while
the projector is in standby mode, set
"Network Monitoring" or "Standby Mode"
to "ON" or "Network ON" in the
projector's configuration menus.

@ Projector's User's Guide

Has a critical problem
developed causing the
projector to momentarily
stop working?

When the projector has momentarily
stopped working, it cannot send e-mail
messages. If the projector cannot be reset
even after it has been checked, contact your
dealer or the nearest address provided in
the World-Wide Warranty Terms supplied
with the projector.

Is power being supplied to
the projector?

Check if the power supply to the location
where the projector is set up has been
interrupted, or if the circuit breaker for the
electrical outlet that the projector is
connected to has been tripped.
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